
Experiment HH-2: The 
Electrocardiogram and Heart 
Sounds
Background

Blood enters the arterial system from the ventricles of 
the heart in a pulsatile manner. However, when blood is 
leaving the arterial system through the capillaries, it 
flows in a continuous manner. Between contractions, 
when the heart is relaxed and blood is not being pumped 
into the arterial system, there is still enough pressure in 
the arterial system to move blood along the arteries. The 
pressure in the arterial system exists because the 
elasticity of the arteries allow them to distend and recoil 
and function as a pressure reservoir.

When the ventricles contract, the pressure of the blood 
inside the ventricles increases to close the atrioven-
tricular valves. Further contraction increases the 
ventricular pressure until it exceeds the arterial 
pressure. At this point, when the arterial pressure is at 
its lowest point during the cardiac cycle (called diastolic 
pressure) the semilunar valves are forced open, and 
blood flows into the artery. Blood entering the arterial 
system inflates the arteries a little and increases blood 
pressure to a maximum, which is the systolic pressure. 

In this lab you will record the ECG from a subject and 
listen to the characteristic “lub-dub” heart sounds. The 
“lub” sound occurs during the early phase of ventricular 
contraction and is produced by closing of the atrioven-
tricular valves, which prevents blood flow into the atria. 
When the ventricles relax, the blood pressure drops 
below what is in the artery and the semilunar valves 
close, producing the “dub” sound.

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

C-AAMI-504 ECG cable and electrode lead wires

EM-100 Event marker

Stethoscope

Alcohol swabs

Disposable ECG electrodes

IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure T-1-1 in the Tutorial Chapter for the location of 
the USB port and the power socket on the IWX/214.

3 Check Figure T-1-2 in the Tutorial Chapter for a picture of 
the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the labeled socket on the rear of the IWX/214. Use the 
power switch to turn on the unit. Confirm that the red power 
light is on.

Start the Software
1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 
the Windows Start menu, move the cursor to All Programs 
and then to the listing for iWorx. Select LabScribe from the 
iWorx submenu. The LabScribe Main window will appear 
as the program opens.

1 On the Main window, pull down the Settings menu and 
select Load Group.

2 Locate the folder that contains the settings group, 
IPLMv4.iwxgrp. Select this group and click Open.

3 Pull down the Settings menu again. Select the ECG-Heart 
Sounds-LS2 settings file.

4 After a short time, LabScribe will appear on the computer 
screen as configured by the ECG-Heart Sounds-LS2 
settings.

5 For your information, the settings used to configure the 
LabScribe software and the IWX/214 unit for this exper-
iment are listed in Table HH-2-1 on page HH-2-1. These 
settings are programmed on the Preferences Dialog 
window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

ECG Cable and Event Marker Setup
1 Locate the C-AAMI-504 ECG cable and electrode lead 

wires (Figure HH-2-1 on page HH-2-2), and EM-100 event 
marker (Figure HH-2-2 on page HH-2-2), in the iWorx kit.

2 Plug the DIN8 connector to the EM-100 event marker into 
the Channel 3 input of the IWX/214 (Figure HH-2-3 on page 
HH-2-2).

Table HH-2-1: Settings on the Channel Window 
of the Preferences Dialog Used to Configure the 
iWorx Recording System for Experiment HH-2.

Parameter Uni ts/Ti t le Sett ing Mode/
Funct ion

Acquis i t ion Mode Chart

Start User

Stop User

Display Time Sec 10

Speed Samples/Sec 200

Channel  A1  ECG S 0.3-35Hz

Channel  A3 Heart  Sounds S DIN8
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3 Insert the black AAMI connector on the end of the ECG 
cable into the isolated inputs of Channels 1 and 2 of the 
IWX/214 (Figure HH-2-3 on page HH-2-2).

4 Insert the connectors on the red, black, and green electrode 
lead wires into the matching sockets on the lead pedestal of 
the ECG cable.

5 Instruct the subject to remove all jewelry from their wrists 
and ankles.

 Figure HH-2-1: The C-AAMI-504 ECG cable with three lead wires attached.

 Figure HH-2-2: The EM-100 event marker.

 Figure HH-2-3: The ECG cable and event marker connected to an IWX/214.

6 Use an alcohol swab to clean a region of skin on the inside 
of the subject’s right wrist. Let the area dry. Then, rough up 
the skin in that area with an emery board. this improves the 
conductivity of the electrodes.

7 Remove a disposable ECG electrode from its plastic shield, 
and apply the electrode to the scrubbed area on the wrist.

8 Repeat Steps 6 and 7 for the inside of the left wrist and the 
inside of the right ankle. 

9 Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the right wrist,

• the black (-1) lead is connected to the left wrist,

• the green (C or ground) lead is connected to the right leg.

10 Instruct the subject to sit quietly with their hands in their lap. 
If the subject moves, the ECG trace will move off the top or 
bottom of the screen. If the subject moves any muscles in 
the arms or upper body, electromyograms (EMGs) from the 
muscles will appear on the ECG recording as noise.

Exercise 1: The ECG in a Resting Subject
Aim: To measure the ECG in a resting individual.

Procedure
1 Click on the Record button, located on the upper right side 

of the LabScribe Main window. The signal should begin 
scrolling across the screen.

Note: If the user clicks the Record button and there is no 
communication between the iWorx unit and computer, an error 
window will appear in the center of the Main window. Make 
sure the iWorx unit is turned on and connected to the USB port 
of the computer. Click OK and select the Find Hardware 
function from the LabScribe Tools menu. 

2 Click on the AutoScale button at the upper margin of the 
ECG channel.

• If the signal on the ECG channel is upside down when 
compared to trace, click on the downward arrow to the left of 
the channel title and select the Invert function. The trace 
should now look similar to the one in the figure

• If a larger signal is required, the electrodes should be moved 
from the wrists to the skin just below each clavicle.

3 When you have a suitable trace, type <Subject’s Name> 
Resting ECG in the Mark box to the right of the Mark 
button. Press the Enter key on the keyboard to attach the 
comment to the data. Record for a minute or two.

4 Click Stop to halt recording. 

5 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder. Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

Data Analysis
1 Scroll through the recording and find a section of data with 

four to six good ECG cycles in succession.
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2 Use the Display Time icons to adjust the Display Time of 
the Main window to show at least four complete ECG 
cycles on the Main window. Four adjacent ECG cycles can 
also be selected by:

• Placing the cursors on either side of a group of four complete 
ECG cycles.

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar to expand the segment with the four 
selected ECG cycles to the width of the Main window.

3 Click on the Analysis window icon in the toolbar (Figure 
HH-2-4 on page HH-2-3) or select Analysis from the 
Windows menu to transfer the data displayed in the Main 
window to the Analysis window (Figure HH-2-5 on page 
HH-2-3).

 Figure HH-2-4: The LabScribe toolbar.

4 Look at the Function Table that is above the uppermost 
channel displayed in the Analysis window. The names of 
the mathematical functions used in the analysis, V2-V1 and 
T2-T1, appear in this table. The values for V2-V1 and T2-T1 
from each channel are seen in the table across the top 
margin of each channel.

5 Once the cursors are placed in the correct positions for 
determining the amplitudes and the beat period on each 
ECG cycle, the values of these amplitudes and the time 
interval can be recorded in LabScribe by typing their names 
and values directly into the Journal, or on a separate data 
table.

6 The functions in the channel pull-down menus of the 
Analysis window can also be used to enter the names and 
values of the parameters from the recording to the Journal. 
To use these functions:

• Place the cursors at the locations used to measure the 
amplitudes and period of the ECG cycle.

• Transfer the names of the mathematical functions used to 
determine the amplitudes and time interval to the Journal 
using the Add Title to Journal function in the ECG Channel 
pull-down menu.

• Transfer the values for the amplitudes and beat period to the 
Journal using the Add Ch. Data to Journal function in the 
ECG Channel pull-down menu.

7 Use the mouse to click on and drag the cursors to specific 
points on the ECG recording to measure the following:

• The R-wave amplitude. To measure the R wave amplitude, 
place one cursor on the Q wave that precedes the R wave and 
the second cursor on the peak of the R wave. The value for 
V2-V1 on the ECG channel is this amplitude. Measure the 

amplitudes of two additional R waves.

• The P-wave amplitude. To measure the P wave amplitude, 
place one cursor on the baseline that precedes the P wave and 
the second cursor on the peak of the P wave. The value for V2-
V1 on the ECG channel is this amplitude. Measure the ampli-
tudes of two additional P waves.

• The T-wave amplitude. To measure the T wave amplitude, 
place one cursor on the baseline that precedes a P wave and 
the second cursor on the peak of the T wave that is in the 
same cycle as that P wave. The value for V2-V1 on the ECG 
channel is this amplitude. Measure the amplitudes of two 
additional T waves.

• The beat period, which is the time interval between two 
adjacent R waves. To measure the beat period, place one 
cursor on the peak of a R wave and the second cursor on the 
peak of the adjacent R wave. The value for T2-T1 on the ECG 
channel is the beat period. Measure the beat period for two 
additional pairs of R waves. 

 Figure HH-2-5: ECG recording displayed in the Analysis window. Lines and 
labels were added to indicate the locations where cursors should be placed to 
measure the amplitudes of R (Q-R), P (Baseline-P), and T (Baseline-T) waves.

8 Calculate the following values and type your results into the 
Journal, or on a separate data sheet:

• The average amplitudes of the P wave, the R wave, and the 
T wave.

• The average beat period, in seconds/beat.

• The heart rate, which is expressed in beats per minute and 
calculated from the average beat period by using the following 
equation:

Heart Rate (beats/minute) =  60 seconds/minute
# seconds/beat

Questions
1 Is the amplitude of each wave (P, QRS, T) always the same 

in different cardiac cycles?

2 Which wave has the largest amplitude? 

3 What is the average resting heart rate of the subject?
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Exercise 2: ECG Recordings from Other 
Subjects 

Aim: To measure heart rate from all students.

Procedure
1 Disconnect the lead wires from the wrists and ankle of the 

first subject.

2 Place new ECG electrodes on another subject. Record the 
ECG from the second subject, as described in Exercise 1.

3 Repeat this exercise on additional subjects, within the time 
limits of the lab period. At the beginning of each recording, 
type the name of the subject on the Marks line and click on 
the Marks button to identify the recording.

Data Analysis
Measure the amplitudes of the ECG waves and beat 

periods of the other subjects using the same techniques 
used in the analysis section of Exercise 1.

Questions
1 Do the P waves of different subjects have the same 

amplitude? The QRS complexes? The T waves? Why?

2 For each subject, determine the wave with the largest 
amplitude. Is this result the same for all individuals?

3 Is the heart rate the same for each individual?

4 What is the range of resting heart rates within the class?

5 Are there any obvious correlations between resting heart 
rate and gender, apparent fitness, or diet of your subjects? 
To determine apparent fitness, the class may want to 
compose a list of questions that will allow you to assign a 
relative fitness factor to each subject. 

Exercise 3: The ECG and Heart Sounds
Aim: To study the phasing of heart sounds to the ECG.

Procedure
1 Place the head of the stethoscope on the left side of the 

subject’s chest and listen for the heart sounds. Move the 
stethoscope head to different positions until heart sounds 
are heard clearly. Heart sounds can also be heard by 
placing the stethoscope over the arteries in the neck.

2 Click on the Record button. Hold the stethoscope head on 
the subject’s chest with one hand and the event marker in 
the other. Press the event marker when you hear the “lub”, 
or first heart sound, and release it when you hear the “dub”, 
or second heart sound.

3 After recording for twenty seconds, click Stop to halt 
recording.

4 Select Save in the File menu on the LabScribe window. 

Data Analysis
1 Scroll through the recording and find a section of data with 

four to six exemplary ECG waveforms and consistent 
responses on the event marker channel, in succession.

2 Use the Display Time icons to adjust the Display Time of 
the Main window to show at least four complete ECG/heart 
sound cycles on the Main window. Four adjacent ECG/
heart sound cycles can also be selected by:

• Placing the cursors on either side of a group of four complete 
ECG/heart sound cycles; and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar to expand the segment with the four 
selected ECG/heart sound cycles to the width of the Main 
window.

• Click on the Analysis window icon in the toolbar (Figure 
HH-2-4 on page HH-2-3) or select Analysis from the Windows 
menu to transfer the data displayed in the Main window to the 
Analysis window (Figure HH-2-6 on page HH-2-4).

 Figure HH-2-6: ECG and event marker recordings displayed in the Analysis 
window. Lines and labels were added to figure to indicate the locations where 
cursors should be placed to measure the time intervals between the R wave 
and the “lub” and the T wave and the “dub”.

3 Once the cursors are placed in the correct positions for 
determining the time intervals on each ECG cycle, the 
values of these intervals can be recorded by typing their 
names and values directly into the Journal, or on a 
separate data table.

4 The functions in the channel pull-down menus of the 
Analysis window can also be used to enter the names and 
values of the intervals from the recording to the Journal. To 
use these functions:

• Place the cursors at the locations used to measure the time 
intervals between the ECG waves and the heart sounds.

• Transfer the name of the mathematical function used to 
determine the time intervals to the Journal using the Add Title 
to Journal function in the ECG Channel pull-down menu.

• Transfer the values for the time intervals to the Journal 
using the Add Ch. Data to Journal function in the ECG 
Channel pull-down menu.
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5 Use the mouse to click on and drag the cursors to specific 
points on the ECG recording to measure the following:

• The R-Lub Interval, which is the time interval between the 
peak of a R wave and the onset of the event mark. The onset 
of the event mark indicates the occurrence of the first heart 
sound or “lub”. Record the value for T2-T1 of either channel. 
Measure this time interval for two additional ECG cycles.

• The T-Dub Interval, which is the time interval between the 
peak of a T wave and the offset of the event mark. The offset of 
the event mark indicates the occurrence of the second heart 
sound or “dub”. Record the value for T2-T1 of either channel. 
Measure this time interval for two additional ECG cycles. 

6 Calculate the following values and type your results into the 
Journal

• The average R-Lub interval.

• The average T-Dub interval.

Questions
1 Why does the lub sound occur around the peak of the R 

wave?

2 Is the time delay between the R wave and the lub sound 
always the same? Explain why the time delay is or is not the 
same.

3 Why does the dub sound occur around the peak of the T 
wave?

4 Is the time delay between the T wave and the dub sound 
always the same? Explain why the time delay is or is not the 
same.
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